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Enhancements and revisions in Adagio BankRec 8.1

The changes and improvements to Adagio BankRec with this release are significant. To make it easier to review the various cha
that have been made, we have grouped them by function in this release note.

 
Generic New Features 

♦ Added new function User Preferences under the File menu. It allows you to set certain options by user that were previously gl
including options previously found under File | 
color and On Start-up functions). The preferences can optionally be set for all users and preferences can be printed. If no individual 
user preferences have been set up for a use
used. 

♦ You can now specify a desktop background color, image and/or text constant to display on the Adagio desktop
display your company logo. Use the text strings to make the company name prominent on the desktop. Any JPG or other graphic 
image can be centered or stretched to fit on the main program desktop. These settings are made on the 
User Preferences function. 

♦ The option 'Auto-advance smart finder' has been added (in the User Preferences function). It controls whether the focus is on the 
previously found grid or on the search criteria field when the smart finder is opened. Select the option if you want focus to
next row in the grid, allowing you to press F6, Enter and 
to search by new criteria each time the smart finder is invoked. In either case the position is advanced in the grid
is opened. When the smart finder Grid is opened, you can toggle the focus between the Grid and the selection criteria by pres
F6. 

♦ The option 'Alphabetically sorted field list' has been added (in the User Preferences function). Tur
lists in the Column Editor and Filters fields 

♦ Column Editor settings are now saved by grid by user by database.

♦ Added the option 'Exclude Ranges' to Report Options (now in the new User Preferences f
and 'Exclude Ranges' is also on, field ranges in general (including date ranges) are not remembered but other report settings
remembered. 

♦ Added Styles and Filters to transactions dis

♦ Styles and Grid Filters for customer and vendor g
Receivables 9.0B or higher, Adagio Payables

♦ Added an Excel Direct button to several grids, including View Transactions, Reconcile Bank and Edit/View Vendors. 
SF Export' option in Edit User to enable or disable the Excel Direct button.

♦ Grids, filters, and finders now show the lookup values instead of the r
Reconciliation and View Transactions grids
are also shown for customers and vendors
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Enhancements and revisions in Adagio BankRec 8.1C (2011.05.12) 

The changes and improvements to Adagio BankRec with this release are significant. To make it easier to review the various cha
ve grouped them by function in this release note. 

Added new function User Preferences under the File menu. It allows you to set certain options by user that were previously gl
including options previously found under File | Options, Reports | Report Options and the Company Profile (company background 

up functions). The preferences can optionally be set for all users and preferences can be printed. If no individual 
user preferences have been set up for a user, all preferences originally set for the Adagio System Administrator, user SYS, will be 

You can now specify a desktop background color, image and/or text constant to display on the Adagio desktop
he text strings to make the company name prominent on the desktop. Any JPG or other graphic 

image can be centered or stretched to fit on the main program desktop. These settings are made on the Appearance tab in the 

has been added (in the User Preferences function). It controls whether the focus is on the 
previously found grid or on the search criteria field when the smart finder is opened. Select the option if you want focus to

ress F6, Enter and select each item in turn through the found list. Turn it off if you usually want 
to search by new criteria each time the smart finder is invoked. In either case the position is advanced in the grid
is opened. When the smart finder Grid is opened, you can toggle the focus between the Grid and the selection criteria by pres

The option 'Alphabetically sorted field list' has been added (in the User Preferences function). Turn this option on if you want field 
fields sorted alphabetically. 

Column Editor settings are now saved by grid by user by database. 

dded the option 'Exclude Ranges' to Report Options (now in the new User Preferences function). If 'Remember report options' is on 
and 'Exclude Ranges' is also on, field ranges in general (including date ranges) are not remembered but other report settings

Added Styles and Filters to transactions displayed in the View Transactions grid in the Balances function

vendor grids are supported in the Customer and Vendor edit and i
Payables is 8.1C or higher). 

several grids, including View Transactions, Reconcile Bank and Edit/View Vendors. 
SF Export' option in Edit User to enable or disable the Excel Direct button. 

lookup values instead of the raw data values for typed fields. For example in 
grids, Entry Type shows Deposit, Payment and Transfer, instead of 0, 1, or 2. 

vendors. 
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Product Compatibility Info link at www.softrak.com. 

OrderEntry 8.1C, 8.1D 
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Receivables 6.8B – 9.0B 

MS Office 2003, 2007 
MS Windows XP, Vista, 7 

The changes and improvements to Adagio BankRec with this release are significant. To make it easier to review the various changes 

Added new function User Preferences under the File menu. It allows you to set certain options by user that were previously global, 
Options, Reports | Report Options and the Company Profile (company background 

up functions). The preferences can optionally be set for all users and preferences can be printed. If no individual 
r, all preferences originally set for the Adagio System Administrator, user SYS, will be 

You can now specify a desktop background color, image and/or text constant to display on the Adagio desktop. Use this feature to 
he text strings to make the company name prominent on the desktop. Any JPG or other graphic 

Appearance tab in the new 

has been added (in the User Preferences function). It controls whether the focus is on the 
previously found grid or on the search criteria field when the smart finder is opened. Select the option if you want focus to be on the 

. Turn it off if you usually want 
to search by new criteria each time the smart finder is invoked. In either case the position is advanced in the grid each time the finder 
is opened. When the smart finder Grid is opened, you can toggle the focus between the Grid and the selection criteria by pressing 

n this option on if you want field 

unction). If 'Remember report options' is on 
and 'Exclude Ranges' is also on, field ranges in general (including date ranges) are not remembered but other report settings are 

grid in the Balances function. 

Vendor edit and inquiry functions (Adagio 

several grids, including View Transactions, Reconcile Bank and Edit/View Vendors. Use the 'Enable 

for typed fields. For example in the 
, Entry Type shows Deposit, Payment and Transfer, instead of 0, 1, or 2. Lookup values 
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♦ Listing button added on the Group Setup window prints all options or enabled options only for a range of groups. 

Edits and Inquiries 

♦ Edit Customer and Edit Vendor functions have been added. Customers and vendors can also be edited from within batch entry. 
These edit functions use a Lanpak license and if another user is already in AR or AP would thus require Adagio Lanpak to be 
installed. The existing view functions do not use a license. 

♦ The Edit and View Customer functions in BankRec support the option to sort transactions and notes added in Receivables 9.0B. 

♦ Copy Banks and Copy Distribution Sets functions place you directly in the edit for the newly created record. 

♦ The Edit Banks screen is sizable. This allows more note lines to be shown in the grid. 

♦ The 'View all' and sort setting on the View Transactions screen in Balances are now remembered by Adagio user. 

♦ Added File | Optional Fields function to allow you to edit optional field settings for customers and vendors from BankRec. 

♦ The field names 'Unmatch debit GL' and 'Unmatch credit GL' on the Interface tab in Edit Banks function have been changed to 
'Unmatch increase GL' and 'Unmatch decrease GL' to avoid potential confusion of debit/credit being from the point of view of your GL 
or that of your banking institution. 

Batch Entry 

♦ 'Auto-transfer banks' allow TelPay or other EFT entries to be posted to an EFT 'bank' then automatically reversed and re-posted to a 
different operating bank. The EFT Bank entry is posted in detail and the operating bank is posted as a single consolidated entry for 
reconciliation. The Auto-transfer happens on post of any batch to the designated bank. In the EFT Bank (Series tab) the option 
'Automatic transfer on posting bank' is set and the 'Transfer to bank' is entered. The Reference and Description for the transaction 
are automatically generated as "AT-bbbb-eeee" (batch-entry) and "Auto Tsfr: BANK1 to BANK2". Automatic fees associated with the 
transfer can be generated at the same time, either as a flat fee or a percentage, by transaction or as a lump sum per transfer. Auto-
transfer batches may also be used to automatically transfer from a payroll bank account to your operating bank. This feature can also 
be used to handle daily credit card deposits with automatic accounting for credit card merchant fees. 

♦ You can now add customers and vendors "on the fly" in batch entry. 

♦ The following fields have been added to the batch status and are available in batch grids, the batch inquiry, and Adagio GridView: 
Created by User, Time Last Edited, Last Edited by User, Date Posted, Time Posted and Posted by User. The date fields are the 
system date (computer date) rather than the session date (Adagio login date). BankRec supports similar fields in the Adagio 
Payables batch status when sending batches to AP. 

♦ Added a Find button for Payments in batch entry to allow you to locate a vendor by entering their name or telephone number 
(Payables 8.1B or higher). 

♦ Supports the ‘Active’ flag in customers in Receivables 9.0A and higher. Grids and finders can optionally be set to hide customers. 
Note: Entering an inactive customer in batch entry does not force you to make the customer active because you must always be able 
to accept a payment from customers. 

♦ Supports the 'Reverse cash invoice with check?', Uppercase vendor code, Auto-fill and Vendor code format options in Payables 8.1B 
or higher. 

♦ Supports the 'Auto-generate invoice number' option in vendors (Payables 8.1B or higher) for vendors who send you a statement 
rather than an invoice. 

♦ Retrieved batches now cannot be deleted if the 'Allow edit of retrieved batches?' option is turned off. 

♦ When cash invoices are entered for existing vendors, Distributions and Distribution Sets defined in Payables are now used rather 
than those defined in BankRec. Miscellaneous vendor payments continue to use BankRec-defined Distributions and Distribution 
Sets. 

Retrieve Transactions 

♦ Added options to automatically post batches retrieved from Payables, Receivables and payroll. These options are on the Options tab 
in the Company Profile. 

Posting 

♦ The Job, Phase and Category (%job) can be used in the User Defined description format send to the GL. For receipts the only the 
job is sent. For payments, only the job of the first payment detail is sent. 

♦ The Receipt Number has been added to the Send to Description in for Receivables on the Interfaces tab in the Company Profile and 
is sent to the cash batch entry in AR. 
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Reconciliation 

♦ Many-to-many matching is now supported during reconciliation. Use shift or ctrl-click to select the transactions from the bank 
statement and outstanding transactions. Drag the transaction in either direction when the amounts match. If the amounts of the 
selected transactions are unequal, then “Cleared with error” may be selected, but the difference in the reconciliation amount will be 
assigned to the “first” transaction in the selected set if you drag from the account to the statement. If you drag from the statement to 
your account transactions, then the error amount will be assigned to the transaction on which the “drop” occurs. All the transactions 
will be marked “Cleared with error”, even though the other transactions will have an error amount of $0.00. 

♦ Improved handling of unmatched downloaded items in the generated batch is now possible by defining a set of rules in the Edit 
Statement Rules function in the Edit menu. Create rules based on transaction description, amount, reference or date to automatically 
assign an imported statement item to a vendor, customer, or general ledger account. Distributions can be selected to automatically 
break out tax credits from the amount imported. Use this facility to automatically distribute credit card expenses to your vendors 
and/or expense accounts. Drive accounting entries back from the imported statement into Adagio automatically to handle credit card 
expenses, account pre-authorized debits or EFT transfers. 

♦ Added Bank Reconciliation function in the Maintenance menu and 'Recon' button on the toolbar. This allows you to access the 
reconciliation function without having to open the Balances function (although you can still also access it from there). 

♦ The Reconciliation function displays a warning if the statement date entered is more than 30 days from the date of the last 
reconciliation. 

♦ When reversing a check you can now specify the date of the reversal transaction (RC) or select an option to use the issue date of the 
check. In previous versions the session date (login date) was always used. Reversing a check as of the issue date is useful when 
reversing postdated checks and simplifies reconciliation by listing a reversal in the same period as the check. The right-mouse popup 
menu has 2 choices for reversing a check: Reversed (login date) and Reversed (check date). 

♦ You can process NSF checks for cash receipts in deposits that have been reconciled. In previous versions you could not do an NSF 
if the deposit had been reconciled. 

Reports 

♦ The Bank Reconciliation report can now be re-printed as of any prior day, provided that transactions have not been purged. 
Backdating the ‘Bank Reconciliation report in prior versions only affected today’s outstanding transactions. Now, you can reprint a 
bank reconciliation as it was on a given day. 

♦ BankRec now uses the Crystal Reports 8.5 print engine. This allows exporting reports to PDF format. 

Print Receipts and the Specification Designer 

♦ Added new spec codes for customer, including the new name field 2 appended to the customer name, and additional address lines 
to handle addresses requiring many fields (city, state, country and zip/postal code): 
C70, Name 1 + 2 
C71, address 6 (formatted) 
C72, address 7 (formatted) 
C73, address 6 (compressed) 
C74, address 7 (compressed) 

♦ Added new spec code to show the customer balance, after the payment is taken into account: 
H47, Balance - Receipt 

Import and Export 

♦ If the Entry number and the Check number are being defaulted for Detail Only deposits, the imported details are all in the same 
entry. In this case the import now separates the details into separate entries by change of customer. 

♦ When importing payments, if the Tax Code is not imported, it is now defaulted from the Distribution Code (If there is one). 

♦ The AP Reference field has been added to import templates. 

♦ Import/Export supports Excel® 2007 format (.xlsx) allowing for more than 65,535 rows in import and export files. Spreadsheets no 
longer need to be re-saved in Excel 97-2003 format (.xls) before they can be imported. 

Maintenance Functions 

♦ Period End has been improved to help prevent accidentally purging of history. The Date field has been renamed to 'Clear reconciled 
transaction history up to' and is not editable. Transactions are purged based on this un-editable date (which is calculated from the 
number of days to keep history in the profile). If the 'Statement Cleared Date' of a reconciled transaction is after the purge date, it is 
not purged, regardless of what the transaction date is. 
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Install Changes 

♦ This version moves toward our goal of a more Windows 7 friendly environment for installation. If you are installing to a mapped 
network drive that is normally accessible, but you cannot see it during the install when attempting to select a drive or folder, you can 
now install by browsing to the correct folder using the Universal Naming Convention (UNC), for example \\myserver\accounting\. This 
avoids having to adjust the User Account Control settings, which requires you to restart your computer and temporarily grant 
Administrative privileges to the user if they are not an administrator. 

♦ This version simplifies installation by removing any consideration of the location of the Report Tables Drive (RTD) by the install and 
program in virtually all cases. Therefore the install no longer prompts for the RTD. 

♦ The install writes to the master install log file "AdagioMasterInstall.log" in the \softrak\system folder. An entry is written to this log 
when any full, upgrade or SP for any Adagio module (with a release date of March 2011 or later) is installed. It shows the version 
installed and the version being replaced, the name of the Windows user who did the install and the rights for that user. An entry is 
also written to the log when an updated version of the Adagio Data Source (ADS) is installed, showing the version installed and the 
version being replaced. This log can be used to quickly determine the install history for all Adagio programs. 

♦ When you select the 'Backup Files' option during an install, the replaced files are now saved in a subfolder named YYYYMMDD in 
the BACKUP folder, under the programs destination folder (rather than the BACKUP folder itself, where extensions need to be 
changed to .001, .002, etc. when there are multiple versions of the same file). 

♦ The install includes an option allowing you to skip creating entries under Windows Start for cases where you will be manually 
creating an icon for the user to start Adagio and do not want them starting from Windows Start. During the install, uncheck the option 
'Start Menu programs'. This avoids having to delete or change the Windows Start entry that would have been created. 

♦ The install no longer checks the Opportunistic Locking setting (Oplocks) on the workstation. 

♦ The Opportunistic Locking setting (Oplocks) on the workstation is no longer checked when the program is started. 

♦ The System Status function in the Help menu (chksys.exe) no longer prompts you to disable Oplocks. It displays the current Oplocks 
setting and allows you to change it. The 'Check R/W Status', 'Check Specific Folder' function now supports UNC browse, whereas 
before you would have had to turn UAC off to use it. 

♦ SetServerForAdagio and SetReportsTablesDrive utilities have been updated. The latter should virtually never be needed at an 
Adagio site once any Adagio module dated March 2011 or later has been installed. 

Problems fixed 

♦ You could not retrieve more than 20 batches from Receivables into BankRec. If more than 20 batches existed the Retrieve Receipts 
function displayed the error "Record locking. Unable to access record in banks. This record is in use by [symbols] in window 
[symbols]." and some batches were not retrieved or were corrupt. 

♦ BankRec now prevents you from reversing a Transfer if the transfer transaction is not outstanding in both banks affected by the 
Transfer. 

♦ If you entered a mix of receipts and payments into a deposit only batch, when a receipt, a payment and then another receipt was 
entered, the Bank Reference from the payment was used as the default for the second receipt rather than the Bank Reference from 
the first receipt. The Batch Listing showed the Bank Reference for the second receipt as a check number, although the batch 
correctly posted a single entry for the deposit. 

♦ A negative receipt copied to an existing batch added to the Batch total instead of subtracting. 

♦ The AP Reference field was not remembered between batch entries when the 'Remember Batch Entry Fields' was set. 

♦ When posting a batch and the ‘Consolidate bank transactions’ option is enabled, the consolidated information retrieved into Adagio 
Ledger is more accurately reflected. 

♦ When batch(es) containing errors were posted, after an error message was displayed, the message "Posting Complete" was 
displayed. The message has been changed to "Posting complete. One or more batches were not posted due to errors". 

♦ You are now prevented from posting a batch if it contains any entries for inactive vendors. A message is displayed indicating the 
entry and the reason. 

♦ If you imported a Bank Reconciliation, used the Auto-Match function, then clicked the Reset button to remove all the pending 
statuses, clicking the Auto-Match button again did nothing until you closed and re-opened the Reconciliation function. 

♦ If you imported a reconciliation and used either the Auto-Match or the drag-and-drop method of matching the imported file to 
reconcile transactions, the Last Status Date field was not set. 

♦ Last Status Date was not set when a batch was generated from unmatched imported transactions. It is now set to the sign-on date. 
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♦ The 'Bank Statements Default' import template was corrupt and contained 2 Bank fields on the Field Defaults tab. To correct this 
problem for existing databases you must manually delete the files beginning with "BRIO" from your data directory. BankRec will re-
create them. However, any custom templates you have created will be lost and must be reentered. Therefore you should print all 
templates before deleting the files. 

♦ In Import Payments, only Cash Invoice type transactions can be imported. However, the Transaction Type was a required field. 

♦ In Import Payments, only Cash Invoices can be imported. Therefore the GL Distribution or GL Account/Department are now required 
fields. 

♦ An error occurred when importing deposits if Adagio Receivables was not used. 

♦ Copy Bank function no longer copies the Last Statement Balance, Last Statement Date and Current Bank Balance. 

♦ The Source field in the Batch Inquiry was blank instead of 'Generated' for batches generated for batches created by unmatched 
import bank reconciliation or the NSF function. 

♦ The Posting Journal did not include the unapplied portion of partially Unapplied receipts in the document summary or in the General 
Ledger Distribution Summary in some cases. 

♦ The Receipt Date range on the report dialog screen for the Receipt Audit List was filtering on the Transaction Date instead of the 
Receipt Date. 

♦ The Bank Notes Detail table was not available in GridView. 

Enhancements and revisions in earlier versions of Adagio BankRec 

♦ Refer to the Readme help file for details of enhancements and revisions in earlier versions or Historical Enhancements under 
Products on Softrak's web site. 

Installing 

To install Adagio BankRec you need the serial number and install code from the download instruction email sent to you by Softrak 
Systems. 

If you are installing an upgrade, you need the upgrade serial number and install code from the download instruction email. A previous 
version of Adagio BankRec should already be installed on your computer before installing the upgrade. If a previous version is not 
already installed, you can still install the upgrade. After entering the upgrade serial number and install code, you will also have to enter 
the serial number and install code from a previous version. 

Read the sections below before installing an upgrade. 

If you are installing a Service Pack, you do not need to enter a serial number or install code. However, a previous version of Adagio 
BankRec 8.1C must be installed before the Service Pack can be installed. 

To install Adagio BankRec, run the program file you downloaded. Once the install program is running, you can click the Help button for 
detailed instructions. If Adagio BankRec is installed on a network, you must also do a workstation install for each workstation running 
Adagio BankRec. Refer to the manual or “Installing on a network” in the Readme help for instructions. 

To install the Adagio BankRec Service Pack, run the Service Pack program and follow the instructions on the screen. After installing the 
Service Pack, a workstation install may be required at each station running Adagio BankRec. To determine if a workstation install is 
required, start Adagio BankRec at the workstation. The workstation install will be automatically started if required. Note: If you are 
updating multiple applications at the same time, it may be faster to run the all workstation install to update all applications at once on the 
station. Refer to “Installing on a Network” in the Readme for instructions. 

BankRec 8.1C requires Adagio Lanpak (if used) to be version 9.0C or higher. Note: the Edit Customer and Edit Vendor functions added 
for 8.1C (previous versions only have View functions) each use an additional Lanpak license when you edit a customer or vendor within 
BankRec, thus if another user is already in AR or AP, would require Adagio Lanpak to be installed in order to use the function. 

BankRec 8.1C requires Adagio MultiCurrency (if used) to be version 8.1B or higher. 

Upgrading to 8.1C from 8.1B  Upgrade Complexity: Easy � 

For multi-currency databases, Adagio Payables must be version 8.0A (2006.06.26) or later and Adagio Receivables must be version 
8.0A (2006.06.25) or later. 

BankRec interfaces with OrderEntry when AR 9.0A or higher is used. Payments entered in OrderEntry (8.1C and higher) flow through 
AR to Adagio BankRec. If earlier versions of AR are used, payments entered in OE must be manually entered in BankRec. 

The database must be converted for use with 8.1C. You can convert your BankRec database at any time. The program allows you to 
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make a backup before proceeding with the conversion. The conversion should only take a few moments. 

You should perform a Data Integrity Check in your current version of BankRec before installing the new version and converting your 
database. Any errors should be rebuilt or dealt with in your current version to ensure a successful conversion. 

Upgrading to 8.1C from earlier versions 

The Previously Opened database list is now saved by Adagio User rather than for all users. The first time an existing user or a new user 
logs into Adagio BankRec 8.1B they will be asked “Would you like your historical company access list set up?” Answer yes to have 
BankRec add all entries from the Previously Opened list from your prior version. It is no longer possible for all users to share the same 
Previously Opened list. 

-- end -- 


